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1 INTRODUCTION TO MS PROJECT 

1.1 WHAT IS MICROSOFT PROJECT  

MS Project is a tool to help you to plan projects, manage and update project 
information, and communicate the status once the project is under way.  

The details of the project tasks and associated resources are entered into the system as 
a new project. The system will then display the data in such a way that the 
relationships of the tasks and their time scales can clearly be seen and potential 
problem areas identified.  

Project data can be entered and/or viewed in the three principal formats:  

- Charts: Gantt Charts, Network Diagram Charts and resources graph 
- Forms relevant to single tasks or ressource 
- Sheets. Table containing all the tasks or all the resources part of the project 
The above can be displayed separately or in any combination of two e.g. 

- Combination view: Task Entry View 
- Top half Gantt chart 
- Bottom half Task form 
To enter data easier or to facilitate the analyse, you can combine any two single-pane 
views on the screen to create a combination view. 

In a combination view, the information in the bottom relates only to the task or 
resources in the top view. 

1.2 PROJECT MANAGEMENT 

At the heart of every project management system is a scheduling algorithm. An 
algorithm is a mathematical or logical equation that solves a complex problem by 
breaking down the problem into simple steps. When scheduling resources and 
parameters are entered into it, the scheduling algorithm produces a project schedule 
that would be very difficult to produce manually. This Input/Output model is 
displayed below.  

 
In Microsoft Project, however complex your project may be, you can vary only 
information regarding tasks or resources. The information you provide is fed into the 
“Black Box” or algorithm, to provide you with a schedule in the form of a Gantt chart, 
Network Diagram Chart, or Resource Graph. In summary, the parameters that you 
enter result in output that is a schedule displayed on various views and forms. 
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1.3 DEFINITION OF SOME TERMS 

Management has proper terms and terminology of which the most important: 

 

 
In the illustration above, the two tasks have a relationship.  

Task A is the predecessor task, and Task B is the successor task.  

Both of these tasks are considered to be non-critical because they both have flexibility.  

- EA marks the earliest possible time Task A can start.  
- SS marks the scheduled start time for Task A.  
By default, all tasks are scheduled to start at the earliest possible time, unless you 
specify otherwise.  

Here Task A is scheduled to start later and therefore has been delayed.  

- SE marks the scheduled end time for Task A, and  
- LE marks the latest possible time Task A can end.  
Both of these tasks have slack: the amount of time a task can slip before it affects 
another task’s dates or the project finish date.  

- Free slack is the amount of time Task A can be delayed before affecting the start 
time of Task B, and  

- total slack is the amount of time that Task A can be delayed before affecting the 
finish date of the project.  

The summary task summarizes Tasks A and B..  

Critical tasks have no slack; therefore, delaying this type of task would mean delaying 
the project.  

A critical path is the serie of critical tasks. All tasks on a critical path must be 
completed on time for the project to finish on time. If one task on a critical path is 
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delayed, then the project is delayed. Generally, the critical path is shown in red on the 
Gantt chart and the Network Diagram Chart. 

Other terms 

Actual Usage: measures the resource expended in completing or partially completing 
a task. 

ALAP: Indicates that the task should be started ‘As Late As Possible’ (using all the 
free-float time available). 

ASAP: Indicate that a task should be started ‘As Soon As Possible’, (taking into 
account the start date of the project and its predecessor tasks). 

Baseline:  Is the original project plan, including the time schedule and resource and 
cost allocations. The baseline is used for comparing projected values to actuals, and 
facilitates the tracking and analysing of a project’s progress. 

Cost Variance A project tracking function recording the difference between the 
budgeted cost of the work performed and the actual cost. Values below the baseline 
show an overspend and positive values denote cost savings. 

Critical Path The sequence of tasks or activities whose schedules and durations 
directly affect the date of overall project completion. 

Earned Value Measures the project’s performance, and is calculated by multiplying a 
task’s planned cost by the percentage of work completed.  

Float (slack) The amount of time by which a non-critical task can be delayed before it 
affects another task’s schedule.  

Gantt chart A graphical representation of a project schedule showing each task as a 
bar, the length of which is proportional to its duration. Many project management 
packages use a spreadsheet section to the left of the Gantt chart to display additional 
information.  

Hammock Task A task whose duration is calculated based on the time span between 
its predecessor and successor activities.  

Histogram A bar chart that shows resource workloads over a time period.  

Lag The amount of time between the finish of a predecessor task and the start of a 
successor task.  

Lead The amount of time that a task is permitted to start before its predecessor is 
finished. 

Loading Resource usage on a task per unit of time. Different methods of loading may 
be used depending on what’s available in your project management application and 
what’s applicable for your particular project.  

Loading(back) A loading pattern that allocates resource usage as late in the task as 
possible.  

Loading (contour) The contour-loading pattern assesses which resources are left over 
after allocation to the critical tasks and spreads these resources among the remainder 

Loading(fixed) When using fixed-loading algorithms, you specify the actual amount 
of resource allocated to the encompassing tasks.  
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Loading(front) Front loading systems will attempt to allocate resources as early in the 
task as possible.  

Loading(uniform) This loading pattern allocates the resource usage on a by day basis 
in a task. This will usually be done without causing any one task to be over committed.  

Milestone A project event that represents a checkpoint, a major accomplishment or a 
measurable goal.  

Negative float Refers to an unscheduled delay before an actual task start time that 
must be recovered if the project is not to be delayed.  

OBS codes Organisational Breakdown Structure codes are used to identify tasks by 
resource groups in a hierarchical format. OBS codes are often used to reflect 
departmental structure in a company or code of accounts, and can also be used for 
filtering tasks.  

Network Diagram Project Evaluation and Resource Tracking charts, also called 
network diagrams. Network Diagrams are a graphical depiction of task dependencies, 
and resemble flow charts. Dependencies are shown by connecting lines or arrows 
indicating the work flow.  

Predecessor In dependency relationships, the predecessor is the task that must be 
started or completed first.  

Project Management Best defined as a body of knowledge, a set of principles, or 
techniques dealing with the planning and control of projects.  

Resource Any person, group of people, item or equipment, service or material used in 
accomplishing a project task. 

Resource levelling The process of resolving resource conflicts. Most project 
management programs offer an automated resource levelling routine that delays tasks 
until the resources assigned to them are available.  

Resource Driven Task durations determined by the program and based on the number 
of an allocation of resources, rather than the time available. Both individual tasks and 
entire projects can be resource-driven.  

Sub-project A group of activities which are treated as a single task in a master project 
schedule. Subprojects are a way of working with multiple projects that keep all the 
data in one file rather than in independent files.  

Successor In a dependency relationship between two tasks, the successor is the task 
that must await the start or completion of the other.  

WBS codes Work Breakdown Structure codes are used to identify tasks in a hierarchy. 
Many project management applications associate these codes with an outline structure. 
WBS codes can be used to filter the project schedule for tracking and reporting 
purposes. 
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1.4 STARTING MS PROJECT  

1.4.1 THE SCREEN  

 
The Menus: Always displayed, some options depend on the selected view. 

Tool Bars: Buttons provide quick access to the most common commands, The bars 
can be customised 

Task Pane If wanted, with options to help when ‘Getting Started’. Other task panes 
are available. 

Entry Bar: The entry point for text with outlining buttons. 

Status Bar: At the bottom of the screen showing the current status. 

Scroll Bars: When using a mouse to scroll the views and to move the boundary 
between two views. 

Working Area: The area for 1 or 2 views, the size of each can be adjusted. 

1.4.2 ELEMENTS OF THE DEFAULT VIEW  

The default Project view is the Gantt Chart view. This view is used extensively in 
Microsoft Project. The Gantt Chart consists of a Gantt table and a Gantt bar chart. The 
divider bar separates the two and can be repositioned to display more of the table or 
more of the chart.  

- The Gantt table consists of rows and columns. Just like on a spreadsheet, the 
intersection of a row and a column is called a cell.  

- The Gantt bar chart graphically displays your schedule on a time line.  
- The status bar displays the current mode of operation and warning messages and 

indicates when special key control modes, such as Num Lock mode, are on.  
- The entry bar contains an Entry box where all information is input.  
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- The default toolbars are the Standard toolbar, Formatting toolbar and the Project 
Guide. Other toolbars can be displayed by choosing Toolbars from the View 
menu. 

1.4.3 VIEWS AND TABLES 

A view is the format of the way that project data is displayed on the screen and there 
are a considerable number of different permutations that can be used.  

The View Menu is the first place where the view that is required is selected. The basic 
selection is between a Chart, a Form, or a Sheet. Some of the options in this menu can 
provide a split view to show two different displays for the same Task or Resource. 

- Calendar: Shows the view in the form of a calendar.  
- Gantt Chart: A diagrammatic view of the Tasks and their time scale. This chart 

can also show the relationship between Tasks and the Critical Path. It usually 
shows the task entry form alongside the Gantt chart.  

- Network Diagram Chart: Network Diagram is an acronym for Programme 
Evaluation Review Technique. This view represents each Task as a box with 
relevant information within it. The layout of the boxes on the chart and the lines 
that link the boxes represent the structure of the project.  

- Task Usage: The Task Usage view displays project tasks with their assigned 
resources grouped underneath them.  

- Tracking Gantt: The Tracking Gantt view displays two task bars, one on top of 
the other, for each task. The lower bar shows baseline start and finish dates, and 
the upper bar shows scheduled start and finish dates (or if the task has already 
started, meaning that the percentage complete is greater than zero, the upper bar 
shows the actual start and finish dates).  

- Resource Graph: A graphical representation of a single resource and its 
utilisation. Resource Sheet: A list of all the resources for the project.  

- Resource Usage: This is a view that shows the use in hours per day for each 
resource.  

- More Views: Allows the showing of combination views as well as details of a 
single Task  

- Table:(Entry): Changes the form alongside the Gantt chart.  
- Reports: Takes you into Report Wizard.  
- Toolbars: Allows you to change the Toolbar display.  
- View Bar: Activates the View bar, located vertically on the left of the screen.  
- Zoom: Changes the amount of information you can see on screen, from days to 

years.  

1.4.4 THE TRACKING GANTT VIEW 

When you initially set up your project with tasks and dates, and then save the project 
with a baseline, the Tracking Gantt view displays those tasks as shown in the 
following example.  

 
The baseline bars and the scheduled or actual bars are synchronized. However, if the 
start date of task slips by, say, 2 days, the red scheduled bar will extend 2 days beyond 
the lower baseline bar. 
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Because the tasks are linked, the slipping of task 2 will cause a ripple effect, making 
its successor tasks slip by 2 days as well.  

You can use the Tracking Gantt view to: 

- See how tasks progress across time and evaluate the slippage of tasks. You can 
track progress by comparing baseline and scheduled or actual start and finish 
dates and by checking the completion percentage of each task. 

- View tasks graphically while still having access to detailed information about the 
tasks. 

- Create a project by entering tasks and the amount of time each task will take.  
- Establish sequential dependencies between tasks by linking them. When you link 

tasks, you can see how a change in the duration of one task affects the start and 
finish dates of other tasks and the project finish date.  

- Assign personnel and other resources to tasks. 

1.5 MS PROJECT – MENUS 

In this chapter only the typical MS Project commands are explained, the other are the 
same or very similar as in other programs. 

1.5.1 THE FILE MENU 

The typical MS-Project command is: 

- Properties: Provides basic information on the Project. 

1.6 THE EDIT MENU 

The typical MS-Project command are: 

- Link Tasks: Create links between tasks. 
- Unlink Tasks: Break an existing link. 
- Go To: Go to a task or resource. (Depends on view.) 

1.6.1 THE INSERT MENU 

The most important MS-Project command are: 

- Insert new rows for tasks or columns for information. 
- Task information dialog box to add more detailed information to the current task. 

1.6.2 THE FORMAT MENU 

This menu changes dramatically when different views are selected.  

The following are the principal selections. 

For a Network Diagram the choices are: 

- Text Styles: Modifies the size, and type of the selected text. 
- Box Styles: Changes the appearance of the Network Diagram boxes. 
- Layout: Allows you to customise the way links are shown. 
- Layout Now: Redraws to show changes made to links etc. 
For the GANTT chart the choices are: 

- Font: Used to change the font. 
- Bar: Change the selected Gantt Bar style 
- Timescale: Allows you to set the displayed time at anything from years to 

minutes. 
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- Gridlines: Allows you to display or hide Gridlines and change theirappearance. 
- Gantt Chart Wizard: Takes you through the programs method of setting up your 

Gantt chart. 
- Text Styles: Change the font, size and colours 
- Bar Styles: Change all Gantt bars. 
- Details: Details of the Gantt chart 
- Layout: Change the way the bars are displayed including links. 

1.6.3 THE TOOLS MENU 

The main choices here are Change Working Time, Tracking and Multiple Projects. 

- Assign Resources: Apply various filters to the tasks. 
- Level Resources: Shows resource levelling information 
- Change Working Time: Format a new Calendar. 
- Tracking: Check the progress. 
- Links Between Projects: Set up sub projects and links. 

1.6.4 THE PROJECT MENU 

This menu is for retrieving information on the project and its components. Some of 
the options launch sub menus. The commands are fairly self-explanatory and will 
become clearer later. 

There are also the usual Window and Help options. 

You will find that the menu choices may change depending on the view selected. 
If this happens it simply means that the option you wanted is not available for 
that view. 

1.7 THE TOOL BARS 

The Buttons provide quick access to some of the commands available from the pull 
down menus. The default arrangement of the toolbars is the Standard and Formatting 
bars active.  

 
The formatting bar is virtually identical to the same thing in other Office applications, 
except it has the Outline tools attached to it. These tools are for promoting and 
demoting tasks, Collapsing and expanding sub tasks plus the usual Text format and 
alignment buttons. 

1.8 LOADING AND VIEWING A PROJECT 

Select File, Open to open any project file. 

- Use the scroll tools to see the project progress. 
- Use the mouse to change the size of the various windows. 
- Alter the time scale with View, Zoom. 
Change the View 
- Click on the View menu. 
- Choose each of the top five and note the different screens. 
- Select View, Gantt Chart to return to the original view. 
- Move the mouse to the central vertical bar on the screen when it will change to a 

double line with a double-headed arrow 
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- Click and hold the left button and drag left or right to see more of the Gantt Chart 
or the table. 

1.9 CHANGE THE PROJECT START DATE 

→ Project → Project Information. 

 
→ Change the project Start Date. 
→Click Add and click OK and examine the views again. 
→Tools →Tracking → Update Project to see project progress so far. 

 
1.10 PROJECT MANAGEMENT 

1.10.1 PROJECT:  

A project is ‘a planned undertaking’ 

The skills of project management are gathered from a wide range of experiences. 
Consciously or sub consciously we all apply these skills in the daily administration of 
our work. 

Where a major undertaking has to be completed, these skills are not only brought into 
focus but must be applied in a much more structured format. 

We must take on the jargon and techniques of the Project Manager as well as become 
familiar with the "Tools of the trade". 

To review the skills that are relevant to project management 

- The ability to define the Goal, Objective, Specifications and Limitations of a 
project. 

- The ability to define the individual tasks in sufficient detail and sequence to meet 
the objective with the minimum of problems, and within the defined time scale. 

Task attributes should include some or all of the following 

- Objectives 
- Time constraints 
- Milestones 
- Task(s) on which this Task is Dependant 
- Estimated Duration: - 
- Task(s) that are dependent on this task 
- (Optimistic estimate) 
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- Itemised task Budget 
- (Pessimistic estimate) 
- Resources required to complete the Task. 
- The ability to manage the progression of the tasks in terms of their resources, 

start times and finish times. 
- The production of appropriate progress reports. 
As the complexities of these undertakings increase so the importance of discipline and 
structure increase and the Project Manager must look to the tools that can help which 
is where Microsoft Project comes into the picture. 

1.11 THE STAGES OF PROJECT MANAGEMENT 

The process of project management is divided into specific stages which can be 
defined as follows:  

- Define the Project 
- Plan the project 
- Implementation 
- Monitoring and Adjusting 
- Evaluation 

1.11.1 DEFINING THE PROJECT. 

Setting out the Goal and the Objectives together with the Specification and 
Limitations within which the undertaking must be completed. 

1.11.2 PLAN THE PROJECT 

Planning of all the activities, resources, and estimation of materials and time scales. 
Some of this planning may have to be done at an appropriate level for cost estimation 
before the project can be agreed. Once the decision to go ahead has been taken the 
skills of the Project Manager are used to define the details of the planning stage. 
When this has been completed and agreed it will become the "Plan" or the base line 
against which progress can be measured. 

1.11.3 IMPLEMENTATION 

Implementation is like leap into the void! 

In average, a poorly planned project will take at least three times longer that the 
original plan.  

A well-planned project will only take twice as long. 

A project that will be completed without changes, on time and within budget never 
happens. 

1.12 MONITORING AND ADJUSTING 

1.12.1 RECORDING ACTUAL PROGRESS 

Once the project is under way, the progress of each activity is recorded. This 
information can then be compared against the Plan and the differences highlighted. 
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1.12.2 REVISING THE SCHEDULE 

The process of minimising the effect of problems and delays on meeting project 
deadlines is achieved by adjusting and updating the Schedule to meet the changed 
circumstances. 

1.12.3 EVALUATION. 

As the project progresses and when it has been completed the process of evaluation 
should be used to learn the lessons for the next time. 
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2 PLANNING THE PROJECT 

Project management is the process of planning, organising and managing tasks and 
resources to accomplish an objective within constraints of time resources (or costs). 

There are six basic steps to follow when planning a project: 

1. Define the project 
2. Plan project activities 
3. Plan for and gather resources 
4. Plan project costs 
5. Plan for quality and risks 
6. Plan security and communication 

2.1 DEFINING THE PROJECT 

This is the starting point for a new project. The following are the areas that must be 
completed (before starting MS Project): 

2.1.1 THE GOAL 

The goal a short statement of what the project should achieve in the broadest terms. 
For example if the project is to build a new road to divert traffic away from a 
shopping centre the goal would be:  

To make access to the shopping centre easier for pedestrians and improve the 
shopping amenities for local residents. 

2.1.2 THE OBJECTIVES 

The objectives can be more specific and there can be any number of them as required. 
To continue the example from above the following are examples:  

- To build a road for through traffic that does not use any existing residential areas.  
- To design the road and the route to allow for the projected traffic flow for the 

next 20 years. 

2.1.3 THE SPECIFICATION 

The specification will provide more detailed areas for the project, for example it may 
specify the broad sections of the project and at what points approvals are required 
before proceeding. There may be a section concerning where resources should come 
from. It may also specify the management team. 

2.1.4 THE LIMITATIONS 

The limitations the restrictions that will affect the project, for example there may be a 
cost limit, there could be a set of regulations that must be adhered to, time may be a 
vital factor. When these areas are clearly specified before the project starts there is a 
much greater chance of the project succeeding and major pitfalls being avoided.  

2.2 PROJECT PLANNING 

This is where the experience and skill of the Project Manager must be used. At this 
point the project is broken down into a series of tasks and you must ensure you have 
all the necessary information for each task.  
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The Project Manager must be confident that it will be possible to control the task as 
listed, if there is any doubt then the task should be broken down into a number of 
smaller tasks, each of which will be easier to control.  

When defining a task the following is a guide to the information required. 

- The Title 
- The Objective of the Task 
- The time required to complete the task. 
- (Give an optimistic and pessimistic estimate.) 
- A note of any previous task or tasks that are associated with this task. 
- The immediate subsequent tasks. 
- The resource(s) that are required to complete the task. 
- Any time constraints that apply. 
When all the tasks have been specified together with their resources, you have 
completed the major part of the planning of the project.  

The next stage is to examine the flow of the tasks and the utilisation of the resources. 
It may well be that some of the resources are over allocated and these problems must 
be resolved or noted.  

At this point it will be possible to Set the Plan, this will become the base line against 
which progress can be measured. 

 
2.3 STARTING A NEW PROJECT 

The Project Info dialog box, illustrated below, records background information and 
allows you to enter scheduling information. The dialog box allows you to specify 
either the project start or finish date. If you enter a start date, the finish date will be 
automatically calculated. If you enter a finish date, the start date will be calculated. 
Note, however, that if you choose to enter a finish date, all tasks will be considered 
critical because they will all be scheduled as late as possible. If you do not enter a 
project start or finish date, Microsoft Project will automatically use the current date as 
the start date. The Project Info dialog box also allows you to specify the project 
calendar, as shown below.  
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Figure 1: The Project Info Dialog Box 

 
Choosing the Statistics button opens the Project Statistics dialog box, below. This 
dialog box displays information on project start and finish dates, duration, work, and 
cost. It also provides comparative statistics you can use to measure the progress of 
your project.  

 
2.3.1 PROJECT PROPERTIES 

You can enter descriptive information about your project in the Properties dialog box. 
This information will help you and others identify the source and purpose of your 
project. The Properties dialog box consists of five tabs, described in the table below.  

- General Provides information about the project, including project name, file type 
and size, file location, dates and times of file creation, most recent modification, 
and most recent access.  

- Summary Provides a description of the project, including title, subject, author, 
company name, manager, category, keywords, and comments.  

- Statistics Provides information about project use, including date created; most 
recent modification, access, and printing; person who last saved it; current 
revision number; total editing time; and summary.  

- Contents Contains schedule information, including project start and finish dates, 
duration, total work and cost, and percent complete.  

- Custom Allows you to enter project properties by which you can search and 
define links to actual values in your project.   

2.3.2 THE CALENDAR 

→ Tools → Change working time 
The Default Working Calendar is used by MS Project to calculate all Timescales and 
Resource costs. It defaults to a working day of 8 hours with the working hours 0800 to 
1200 and 1300 to 1700. You can create your own calendar with your own particular 
times. If this is not a standard 8-hour day you must remember to tell MS Project what 
the standard day is. Each resource you add will be based on the calendar you select 
when you start your project. Depending on the nature of your project you may find 
that the base calendar and standard 8-hour day is satisfactory. A full day’s work is 
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considered as two shifts, one in the morning and one in the afternoon. You can use the 
From and To text boxes in the Working Time area to specify up to three shifts. 
Selecting Default restores selected days and working hours to their default settings. 
Figure 2: The Change Working Time Dialog Box 

 
Resource calendars deal specifically with resources that is, working hours, working 
days, and vacations on an individual basis. Resource calendars are created 
automatically when a resource is added to the pool.  

Creating a New Base Calendar 
When creating a new calendar, you have the option of creating a brand new calendar 
or of creating one based on an existing calendar, as indicated below 
→ Tools menu → choose Change Working Time→New 
→In the Name text box, type the new calendar’s name. 
→ Select either the Create new base calendar or Make copy of calendar option button. 
→  OK. 
- If required, select the desired month by clicking the up/down arrow on the 

vertical scroll bar of the calendar. 
- In the calendar, either select specific dates for which you want to make a change 

or select all days of the week by selecting the column headings. 
- Specify the changes to be applied to the selected days, i.e., working, nonworking, 

default, or hours. 
→ OK 
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3 TASK ENTRY AND LINKING 

3.1 ENTERING TASKS 

This is the main activity in setting up a new project. The tasks which have been 
identified at the Design Stage must be entered.  

The system will hold task information in a task database, which we cannot access 
directly but is used by the system whenever we view task data. It is one of two 
databases the system uses the other being the resource database.  

It is important to understand that the system checks the data that it holds and where 
necessary introduces changes to make the event possible. It is important to keep an 
eye on this process. As soon as an entry is made the program will update the 
appropriate data and views to reflect the entries. The order of entry should be in the 
logical progression but this is not essential as it can be changed.  

Normal Task entry will be by using the standard Task Sheet. The Gantt View shows 
the Gantt Chart in the right part of the window with the Task Sheet in the left part.  

The Task Information box/Task Sheet 

 
The Task sheet is a view of the selected task with information shown as follows:  

- Name: The Name of the Task. 
- Duration: The time the Task will take including the time units. 
- Start Date: This is the current Scheduled Start date for the Task (Not the 

Planned or Actual Start). 
- Finish Date: The Scheduled Finish date. 
- Predecessors: The ID numbers for the preceding Tasks that are linked to this 

Task. 
- Resources: The names of the resources performing or used in the Task. 
It is possible to select the Task Entry view to see the Gantt Chart in the upper pane 
and the Task Form in the lower pane.  

→View → More Views → Task Entry.  

3.2 TABLES AND DESCRIPTIONS 

3.2.1 RESOURCE TABLE 

- ID: The identification number of the Resource 
- Resource Name: The name of the resource. 
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- Units The number of units available for the resource. 
- Work The amount of work currently assigned to the resource. 

3.2.2 PREDECESSOR TABLE 

- ID The identification number of the Predecessor. 
- Predecessor Name: The name of the Predecessor. If this is not entered the 

system will look it up using the ID number. 
- Type: The relationship with the current Task which will be FS, or SS,or FF. 
- Lag The time delay between the end of the Predecessor the start of the Successor. 
It is not necessary to complete all the fields at entry time, as more information is 
added so the system will update the boxes. It is only necessary to enter the data that 
has been determined in the design stage. 

3.3 LINKING TASKS 

In order that the system is able to display the overall time aspects of the project, each 
Task must be defined in terms of the Tasks on which it is dependent and in turn those 
Tasks that are dependent on it. It is also possible to define in what way these 
dependencies exist.  
Most associated Tasks will have a straightforward linear relationship. That is, the 
preceding task must finish before the next task can start. This is the Finish to Start 
relationship.  

This is not true for all situations, for example if bricks are being made to build a house, 
the building cannot start until some bricks are available but it is not necessary for all 
the bricks to be made before the building can start. The relationship between making 
the bricks and building the house can be described as Start to Start but with a time lag 
to allow for the first batch of bricks to be ready.  

An alternative relationship can be Finish to Finish which is true where two tasks must 
be ready at the same time. For example in the preparation of a banquet, the elements 
of each course must be completed at the same time in order that they are at their best. 
The main three relationships are  

- Finish to Start (FS) 
- Start to Start (SS) 
- Finish to Finish (FF) 
We can also fine tune these relationships by specifying Lag or Lead times as required. 
Linking of Tasks can be achieved by making the appropriate entry in any of the task 
views or highlighting the tasks and using the link button on the Tool Bar, or by using 
the → Edit→Link Tasks command. 
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You need to highlight the tasks you want to link before trying to link them. Use the 
mouse while holding down the [Ctrl] and/or [Shift] button(s) to do this 

3.4 DEFINING THE SUMMARY TASKS 

 
Microsoft Project provides the ability to structure the tasks by setting different levels 
of tasks and grouping tasks under a summary task.  

This can be useful where the project has a considerable number of tasks; management 
can be made easier by only viewing and reporting on the summary tasks. There are 
five buttons on the far left of the Formatting Toolbar which can be used on a single 
task or group of highlighted tasks.  

 
- Promote the selection to the next higher level 
- Demote the selection to the next lower level 
- Expands a summary task to show its subordinate tasks 
- Collapse a summary task to hide the subordinate tasks 
- Hide assignments 
- Show all subtasks, or those of a particular outline level. 
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4 RESOURCE MANAGEMENT 

The management of resources is a major feature of MS Project. It is possible to see 
how each one is being used and determine the times when they are under or over 
utilised. The system can adjust the project to eliminate over allocation of a resource. 
We can think of resource data being stored in a database, which is the partner to the 
task database. The Microsoft Project system merges the data in the two databases to 
provide the facilities that are available. There are a number of ways we can view the 
resources, as the following topics will show.  

4.1 DEFINE THE RESOURCES 

Complete a resource table for the resources used in the Project Plan 

Figure 3: Resource table 

 
When you build a large pool of resources, for example, 200 employees, the best place 
to enter this information is in the Resource Sheet. If there are only a few resources 
working on the project, however, you might enter them “on the fly” using the 
Resource Assignment dialog box or the resource sheet.  
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- Resource Name The name given to a resource. It can be the name of an 

individual or a type of group.  
- Initials The abbreviated name for the resource.  
- Group A resource can be placed in a group, which can be used by a filter to show 

only group members, it is also possible to use the group name to view all 
members of the group together.  

- Max. Units The percentage (number) of resource units available. This is 
applicable only if using a type of resource. For example, you might have three 
technicians, but you can have only one Emma Cheesman.  

- Std. Rate The standard cost of the resource per hour, week, or month.  
- Ovt. Cost The overtime cost of the resource per hour, week, or month.  
- Cost/Use The cost of the resource every time it is used.  
- Accrue At This field identifies when the cost of the resource is added to the 

running total of the project. The options are at the "Start", at the "End" or 
"Prorated" which means updated at the end of each time unit as the resource is 
used.  

- Base Calendar The base calendar to which you assign the resource.  
- Code You can assign an alphanumeric code to each resource. The Code field can 

be used to associate an accounting code for use of the resource. This is an 
additional method of allocating the costs of the project as required.  

4.2 REVIEW RESOURCE USAGE 

It is vital that after entering all the tasks and allocating resources the utilisation of 
each resource is checked for over allocation. Where this occurs it will mean that the 
project timetable will not be met and the completion date will be delayed. The two 
views listed below can be used to examine where over allocation has happened. It is 
also possible to check these using the search button from the tool bar. An over 
allocation can be cleared by increasing the capacity of the resource i.e. extra units, or 
by moving the tasks. The latter option is known as resource levelling and the system 
can calculate automatically if required.  
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4.2.1 RESOURCE USAGE 

This view will show a table of all the resources and the respective usage in hours per 
day. Where the resource is over allocated the entry will be in an alternative colour. 

4.2.2 RESOURCE GRAPH  

The Resource Graph is used to display the usage of a single resource and will 
highlight the times the resource is over allocated. The Graph can be accessed from the 
View pull down menu and will show the current selected resource  

4.2.3 RESOURCE LEVELLING  

Levelling is the process of moving tasks in the time scale to redistribute the use of 
resources where they are over allocated. This process can be automatic whenever 
there is a resource over allocation or manually from the Tools pull down menu.   

4.3 PLANNED TIME SCALE 

When all the tasks and resources have been added and any resource problems cleared 
and provided the scheduled dates are acceptable, this marks the completion of the 
design and planning stage.  

All of the data entered into the project at this time can be considered as the base line 
for the project to be managed from and measured to. Microsoft Project will hold this 
data by using the Tracking, Save Baseline command from the Tools menu.  

From this point, as the tasks are completed and the data updated it will be possible to 
make comparisons with the plan and determine how late (or early!!!) the completion 
date will be and where the problems are occurring. This can be seen using the View, 
More views, Tracking Gantt. The Plan appears as grey brs under the Gantt bars. 

Lead Time and Lag Time 
Certain tasks can be started before other tasks are completed.  

4.4 THE OUTLINING VIEW (SUMMARY) 

Outlining is used for organization and categorization. Outlining lets you arrange tasks 
in a hierarchical structure and identify project phases. You can use a top-down method 
for outlining, which allows you to enter the major phases first and then add details. 
You can also use a bottom-up method, which allows you to enter all tasks first, and 
then group them in phases once their relationships become clear. With Outlining, you 
can display and/or report only certain levels of detail.  

Outlining allows you to organize tasks at up to ten outline levels. Outlining is 
indicated on the Gantt Table by the task’s level of indentation and on the Gantt bar 
chart by the bar shape and pattern. Normal tasks are subordinate tasks, or subtasks, 
when have a higherlevel task above them. A task that summarizes tasks at the next 
level down is called a summary task. Microsoft automatically determines the 
summary task values (duration, cost, and so on) based on information from the 
subtasks at the next outline level down   
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5 DISPLAY DATA AND COST FACTORS 

5.1 USING GANTT CHARTS 

5.1.1 GANTT CHART PRINCIPALS 

The Gantt Chart is a horizontal bar chart that represents each task in the time scale of 
the project. Each task entered in the project will be shown.  

The Gantt Chart can be used to visually keep track of the tasks and also can be used to 
identify important points about each task. For example those tasks that together 
control the completion date are known as the critical Path and are shown differently to 
highlight that fact.  

Gantt Charts can be printed and therefore form the significant part of a regular report 
which shows the current progress, comparison with the original plan, and the new 
projected completion data. 

5.1.2 CHANGING TIME SCALE 

The time scale on the right side of the chart can be changed directly by using the View, 
Zoom command or with the Format, Timescale command. Where the latter is chosen, 
the dialog box will provide the ability to change both the major and minor time scales 
and within each of these it will be possible to alter the units, the label, the alignment, 
and the count of the interval between the unit labels.   

 
5.1.3 CHANGING THE PALETTE 

The Palette can be accessed from the Format, Bar command or by double clicking on 
the Gantt Chart. This dialog box can be used to maximise the information provided by 
the format of the bars on the Gantt Chart. The appearance of the existing bars can be 
changed and additional bars can be used. The full use of colour is also possible.  
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For example it is possible to show the planned, actual and scheduled times for each 
task.   

5.2 USING NETWORK DIAGRAM CHARTS 

5.2.1 NETWORK DIAGRAM CHART PRINCIPALS 

The term Network Diagram is derived from Programme Evaluation and Review 
Technique which was invented for the management of Projects by paper based 
systems. This chart is a diagrammatic view of the tasks where the position of the task 
and the lines linking them together represent the detailed steps that comprise the 
project. It is possible to modify the project in the Network Diagram by adding extra 
tasks or nodes and creating the links. Each task on the chart is known as a node and 
within the node is a selection of the data that is relevant to the task. The Nodes can 
have different boarders which represent the task type. 

5.2.2 USING THE FORMAT, BOX STYLES AND LAYOUT COMMANDS 

You must have the Network Diagram view active to see Box Styles and layout as 
options in the Format menu. 
Within these command box (shown below) there are many different types of Task, 
each of which can be given a combination of line style and colour to provide visual 
identification, for example the critical tasks can have thick red borders.   
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5.3 THE TABLES 

Much of the data the system holds can be entered and/or viewed in a table format. The 
system will allow the user to organise these tables so they can be used to maximum 
effect.  

The content of the table is also dependent on the area of project management they are 
used for. There is a difference between tables for Tasks and table for Resources.  

The idea of changing a table structure is to make its use more appropriate to the users 
needs in terms of what information the user needs to view. For a task table there are 
over one hundred possible columns from which the structure can be chosen. For 
Resources the number of possible columns is approximately thirty.  
→ View → Table → More tables 

5.4 EXAMINING THE COST FACTOR 

When all the tasks and their associated resources have been entered, it is possible to 
view the calculated costs of the project and there are several views that can be used. 
The first view is the Task Sheet together with the Cost Table (View, Table, Cost). 

 
This view will list all the tasks as originally entered and the associated columns will 
contain the cost data in terms of the Planned cost, the Actual cost and how much has 
been used so far.  

This table is very useful in identifying those tasks that are causing the greatest 
pressure on the total cost of the project.  

A second way is to chose the Resource Usage then use Format, Details, and choose 
Cost or Cumulative Cost.. 

 The cost totals will not include any material costs. 
Changing the Project to Reduce Costs 
To state the obvious, there are a number of ways the costs can be reduced as follows. 

- A reduction in the cost per time period of each resource. 
- A reduction in the time a task will take to complete. 
- Where possible a reduction in the use of labour in overtime hours. 
- It may be that where some resources are in slack time and cannot be used, a 

waiting charge is payable. This can be minimised by re-scheduling to minimise 
this resource slack time. 

MS Project does not have any easy cost reducing commands, where any of the above 
savings can be made the necessary changes to the project must be entered by using the 
editing methods available. 

View → Resource usage → format → Details 
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6 PRINTING AND REPORTING 

6.1 PAGE SETUP 

Before printing it is advisable to check the Page Setup which is accessed from the File 
pull down menu. 

In the dialog box the following tabs can be selected:  
- Page: Choose orientation and scaling. 
- Margins: Set the margins and borders. 
- Header: This box can hold a Header that will be printed on every page. 
- Footer This box can hold the footer for every page. 
- Legend: This is for printing Gantt and Network Diagram views only 
- View: Choose number of columns of task form etc. if appropriate. 
In the Header, Footer, and Legend buttons are available to enter specific information. 
For example the following are available: These include date, time, page number and 
number of pages. The Page size is available under the Printer, Setup option. 

Check the Settings for the Gantt Chart 
- Ensure you are viewing the Gantt Chart. 
- Pull down the File menu. 
- Select Page Setup. 
- Select Landscape in the Page box. 
- Check the other settings and change any that are not correct. 
- Press the Print Preview button. 
If the Page Setup has been completed for the views that are to be printed then it is 
only necessary to bring the required view on to the screen and select the print 
command. The settings in Page Setup will align all the necessary settings for the 
printer and then print the view in as many pages as it takes.  

There is a Print Preview button in the print dialog box for viewing the printout on 
screen; single or multiple sheets can be shown. It is good practice to check this before 
printing. Other charts are also fairly easy to produce.  

6.2 REPORTS SETUP 

MS Project has a number of pre-defined reports based on six principal types which 
can be used directly, changed as required. Alternatively, completely new reports can 
be created. The system is picture driven and simple to use.  

Access is from the View, Reports command. A dialog box appears in which the 
following type of report can be chosen:  
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- Overview: Summarizes the most significant project information, including 
numbers of tasks and resources, task and schedule status, costs, start and finish 
dates, and so on. 

- Current Activities: Displays information about top-level tasks for the entire 
project. Includes summary tasks and task notes.  

- Costs: Shows critical tasks for the entire project. Includes summary and 
successor tasks and task notes.  

- Assignments: Shows project milestones. Includes summary tasks and task notes. 
- Workload: Shows working and nonworking times for resources for the entire 

project duration.  
- Custom: Use an existing report to create a new one.  
After selecting one of the above you then choose Select and a second box will appear 
that will have a number of pre-defined options depending on the base of the report. 

Most of your reports will be available from the pre-selected ones. The Custom choice 
will allow you to design a very specific report if required. Using this feature will 
hopefully now be familiar to you as the principle is not dissimilar to and easier than 
editing tables and filters.  

When creating a custom report format the Custom Report box will display 25 options 
with sub selection possibilities which can be used directly or edited according to your 
needs.   

 
6.3 REPORTS BY REPORT TYPE 

6.3.1 PROJECT EVOLUTION 

A list of project phases (summary tasks) and 
durations and a Gantt bar chart showing summary 
tasks. 

Gantt Chart view, Entry table, and Summary 
tasks filter  

A list of tasks and durations and a Gantt bar chart 
showing tasks, durations, task relationships, and 
assigned resources. 

Gantt Chart view, Entry table, and All Tasks 
filter.  

A list of tasks showing the actual start and finish 
dates, the percentage of each task completed, and the 
actual and remaining task durations. 

Gantt Chart view, Tracking table, and All 
Tasks filter.  

Scheduled tasks in a calendar format. Calendar view and All Tasks filter.  

6.3.2 PROJECT OVERVIEW AND KEY DATA 

To Print  Use 
The number of tasks and resources, the project cost, 
the total amount of work, and the project start and 
finish dates. 

Project Summary report (Overview reports) 

A list of the highest-level summary tasks showing 
the scheduled start and finish dates, the percentage 

Top-Level Tasks report (Overview reports) 
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completed the cost, and the work.  

A list of milestone tasks sorted by start date. 
Milestones report 

(Overview reports)  

Working and non-working time in your schedule. Working Days report (Overview reports) 

A list of critical tasks showing the scheduled start 
and finish dates and the predecessors and successors 
of each task. 

Critical Tasks report (Overview reports).  

6.3.3 COST INFORMATION 

To Print  Use 
The cost of each task per week, along with the total 
cost of all tasks per week and the total cost of each 
task.  

Weekly Cash Flow report (Cost reports). 

A list of resources whose costs are going to exceed 
the baseline cost.  

Overbudget Resources report (Cost reports).  

A list of tasks showing whether you are ahead of or 
behind schedule as compared with the actual costs 
incurred. 

Earned Value report (Cost reports). 

A list of tasks showing the budgeted cost of each 
task and the variance between budgeted costs and 
current costs. 

Budget report (Cost reports). 

A list of tasks whose costs are going to exceed the 
baseline cost. 

Overbudget Tasks report (Cost reports).  

A summary of resource costs. Resource Sheet view, Cost table and All 
Resources filter. 

Cost information broken down by task and resource 
over time. 

Crosstab report with tasks selected under 
Row, Cost selected under Column, and With 
Resource Assignments selected in Crosstab 
Report dialog box. 

6.3.4 INFORMATION ABOUT RESOURCE USAGE 

A list of resources showing the tasks to which each 
resource is assigned and the amount of work 
assigned to each resource per week. 

Resource report (Assignment reports). 

A list of resources showing their assigned tasks, the 
work scheduled for each task, the start and finish 
dates, and additional resource information. 

Who Does What report (Assignment reports). 

A list of resources showing their assigned tasks and 
the daily work scheduled for each task. 

Who Does What report (Assignment reports). 

A resource's tasks, broken down by week. Weekly To-Do List report (Assignment 
reports). 

A list of tasks showing assigned resources and the 
amount of work assigned to each resource per week. 

Task Usage report (Workload reports). 

A list of over-allocated resources and the tasks to 
which they are assigned. 

Over-allocated Resources report (Assignment 
reports).  

A list showing detailed work information for each 
resource. 

Resource Sheet view, Work Table, and All 
Resources filter.  

A list showing resource use over time, along with the 
cost, the work, and the pay rate of each resource. 

Resource Usage view, Summary table, and 
All Resources filter. 
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A graph showing the amount of work assigned to 
each resource over time. 

Resource Graph view and All Resources 
filter.   

A list of tasks showing start and finish dates and 
assigned resources. 

Task Sheet view, Entry table, and All Tasks 
filter.  

A list of planned and actual resource costs. Resource sheet view and Cost table. 

A graph showing cumulative cost per resource over 
the life of the project. 

Resource Graph view with Cumulative Cost 
chosen from Details submenu on Format 
menu. 

6.3.5 INFORMATION ABOUT TASKS 

A list of tasks that are currently in progress showing 
the months in which each task occurs 

Tasks In Progress report (Current Activity 
reports).  

A list of tasks starting within a time period that you 
specify. 

Tasks Starting Soon report (Current Activity 
reports).  

A list of tasks that haven’t started. Unstarted Tasks report (Current Activity 
reports).  

A list of tasks that should have started by the date 
you specify 

Should Have Started Tasks report (Current 
Activity reports).  

A list of the tasks that have been rescheduled to 
occur after their baseline start dates 

Slipping Tasks report (Current Activity 
reports). 

A list of completed tasks showing the months in 
which each task occurred 

Completed Tasks report (Current Activity 
reports). 

A list of tasks showing the scheduled start and finish 
dates, the baseline start and finish dates, and the 
difference between scheduled and baseline dates. 

Task Sheet view, Variance table, and All 
Tasks filter. 

A list of completed tasks. Task Sheet view, Entry table, and Completed 
Tasks filter.  

A flow chart, or network diagram, showing all tasks 
and task relationships. 

Network Diagram Chart view.  

 


